
NEWSLETTER #94 - September 2020

I am beginning to think it takes a month to 
write our monthly newsletter and I believe the printers are thinking the same!  
Still, who else keeps you up to date with all things Excel and Power BI?

This month, we are pleased to announce the new book, Continuing Financial Modelling, is out – albeit in Kindle form for the time being.  
More details may be found below.

There’s plenty of news inside: workbook links come to Excel for the Web, Office Scripts has a revamp, we finally obtain access to some 
of the new data types in Excel, and we also take a look at how Excel UserVoice has been improving the 30-year-old software.

We also have our monthly regulars Beat the Boredom, Visual Basics, Power Pivot Principles, Power Query Pointers, 
Power BI updates for Desktop, Service and Mobile, there’s more F-ing A to Z of Excel Functions and even space for 
Keyboard Shortcuts (except we don’t consider the SPACE bar this month…).

Happy reading and remember: stay safe, stay happy, stay healthy.

Until next month.

Continuing Financial Modelling
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Liam Bastick, Managing Director, SumProduct

My father used to say I always had to go everywhere twice – the second 
time to apologise.  It seems the same is true for books.  As we wait for 
An Introduction to Financial Modelling to be turned into a Hollywood 
blockbuster (it’s rumoured Brad Pitt’s brother, Cole, will play the lead 
model), the second instalment, Continuing Financial Modelling, is to be 
released in September.

Due to current pandemic circumstances, the physical release has been 
understandably delayed, but the Kindle version will be available on 

Amazon websites from early September.  This sequel contains no SQL, 
but it does contain what-if? analysis, discussions on inventory modelling, 
depreciation modelling, debt sculpting, valuations modelling, rolling 
budgets and charts, and some of the very newest features coming out 
of Excel, amongst other things.  It also has all the usual terrible puns and 
appalling sense of humour that you have come to know and expect from 
its author, yours truly.

And be warned – work is already underway on Volume 3…
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Excel for the Web Workbook Link Support
One common action undertaken in the PC and Mac desktop variants of Excel is linking between files.  This provides a record of where the data was 
sourced from and, if the data changes, it is easily refreshed.  This has been missing from Excel for the Web.  But not anymore: Microsoft has just 
announced that workbook link support is now rolling out for its online cousin.

To create a new workbook link, follow these simple steps:

	 •	 open two workbooks in Excel for the web (they should be stored in either OneDrive or SharePoint)

	 •	 in the source workbook, copy the range

	 •	 in the destination workbook, ‘Paste Links’ via the right-click menu or via ‘Paste Special’ on the ‘Home’ tab.
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Alternatively, you may reference the workbook explicitly (no, not by swearing at it!) using the following reference pattern:

='https://domain/folder/[workbookName.xlsx]sheetName'!CellOrRangeAddress

Now that linked workbooks are possible, when you open a workbook that contains workbook links in Excel for the Web, you will see a yellow bar 
notifying you that the workbook is referencing external data, similar to the desktop versions of Excel:

If you ignore or dismiss the bar, you will not be able to update the links.  This will mean the values will remain as previously displayed.  If you click the 
‘Enable Content’ button, Excel for the Web will retrieve the values from all the linked workbooks.

To help you manage these links, Microsoft has added a new ‘Workbook Links’ task pane.  This task pane may be accessed by pressing the ‘Workbook 
Links’ button on the Data tab 

or via the ‘Manage Workbook Links’ button (on the yellow bar above).

The task pane looks like this:

The task pane will list all of your linked workbooks and provides you with information on the status of each of the linked workbooks.  If the link cannot 
be updated, the status should explain the cause.  This way you should quickly spot issues, with any workbook that cannot be updated highlighted at 
the top of the list. 

At a global level you may take the following actions:

	 •	Refresh all: this triggers an immediate refresh of all linked workbooks
	 •	Refresh links automatically: when enabled, this causes Excel to periodically check for updated values while you are in the workbook
	 •	Break all links: this removes all the workbook links by replacing those formulae with their current values (i.e. Paste Special as Values).

At a workbook level you may take the following actions:

	 •	Refresh workbook: this triggers an immediate refresh of the linked workbook
	 •	Open workbook: this opens the linked workbook in another tab
	 •	Break links: this removes links to that workbook by replacing those formulae with their values (i.e. Paste Special as Values)
	 •	Find next link: this selects the next occurrence of a link to that linked workbook (yay, finally – a quick method for finding those pesky 	
		  phantom links – it would be nice if this could be done for the desktop more simply too…).
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There’s one more thing to note.  Microsoft is at it again.  Not content 
with renaming Windows and Office applications and channels, they have 
decided to start renaming other things end users have understood well 
for years.  Microsoft notes that direct links to external workbooks have 
historically been referred to simply as external links.  They feel it is time 

to make a change, as more external data sources are added to Excel, this 
term will become more ambiguous (no, they will still be external links).  
Therefore, please note to “…improve clarity going forward…”, the term 
workbook links will be used instead.  You have been warned – but at 
least you can now link using Excel for the Web!

Office Scripts Gets a Facelift
Office Scripts in Excel for the Web has been around a while now and allows you to automate Excel tasks online.  As we have explained previously, 
Excel actions may be recorded with the Action Recorder, which creates a “script”.  These may also be created and edited with the Code Editor.  These 
scripts may then be shared with others to automate workflows, etc.

Office Scripts in Excel for the Web is presently in public Preview (I must admit it has taken me forever to get it personally) and needs to be enabled 
by your administrator.  To use Office Scripts, you'll need the following:

	 1.	 Excel for the Web (other platforms, such as desktop, are currently not supported)
	 2.	 Office Scripts enabled by your administrator
	 3.	 Any commercial or educational Microsoft 365 license with access to the Microsoft 365 Office desktop apps, such as:
			   •	 Office 365 Business
			   •	 Office 365 Business Premium
			   •	 Office 365 ProPlus
			   •	 Office 365 ProPlus for Devices
			   •	 Office 365 Enterprise E3
			   •	 Office 365 Enterprise E5
			   •	 Office 365 A3
			   •	 Office 365 A5.

(It’s good to see they Microsoft has updated the names of its products – not!)

Scripts allow you to record and replay your Excel actions on different 
workbooks and worksheets.  If you find yourself doing the same things 
over and over again, this is an ideal candidate for an Office Script.  Once 
coded or recorded, you may run your script with a button-press in Excel 
or combine it with Power Automate to streamline your entire workflow.

For example, imagine you regularly open a .csv file from an website in Excel.  
You then spend several minutes deleting unnecessary columns, formatting 
a table, adding formulae and creating a PivotTable in a new worksheet.  
These actions may be recorded once with the Action Recorder.  From then 
on, running the script will take care of your entire .csv conversion.

The Action Recorder records actions you take in Excel and saves them 
as a script.  With the Action recorder running, you can capture the 
Excel actions as you edit cells, change formatting and create tables.  

The resulting script can be run on other worksheets and workbooks to 
recreate your original actions.
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All scripts recorded with the Action Recorder may be edited through 
the Code Editor.  This lets you modify / amend the script to better suit 
your precise needs.  You can also add logic and functionality that is not 
directly accessible through the Excel user interface, such as conditional 
statements (if then else) and loops.  Just like many have with VBA, one 
easy way to start learning the capabilities of Office Scripts is to record 
scripts in Excel on the web and view the resulting code.  

Office Scripts may be shared with other users of an Excel workbook.  
When you share a script with others in a workbook, the script is attached 
to the workbook.  Your scripts are stored in your OneDrive, and when 
you share one, you create a link to it in the workbook you have open.

Furthermore, Power Automate is an additional service that helps you 
create automated workflows between multiple applications and services.  
Office Scripts can be used in these workflows, giving you control of your 
scripts outside of the workbook.  You can run your scripts on a schedule, 
trigger them in response to emails and more – with just a little practice.

That’s old news.  However, Microsoft has recently announced the 
application programming interface (API) has been simplified for Office 
Scripts in public Preview.  The modified API design has added features 
intended to maake the script development easier.  It carries forward all 
the functionalities provided by the previous model and has been adapted 
to make the learning and development process more straightforward.  
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Examples of the simplified Office Scripts API include:  

	 •	 Office Scripts APIs may be invoked in a synchronous manner (i.e. the code waits for one task to finish before another starts) without trying to 	
		  comprehend programming concepts / complexities such as promises or callbacks
	 •	 Easier API design that includes simple object collections, getter and setter methods for property access, better error handling options, etc. 
	 •	 Improved APIs to interact with Excel objects such as range cell, table rows and columns
	 •	 Development time static type checks offered by TypeScript language based IntelliSense. 

There’s nothing to do in order to get the simplified API features; users 
will automatically create scripts with the new APIs when the feature 
is fully available in public Preview.  This includes the newly recorded 

actions and new scripts created using the Code Editor.  You can identify 
the simplified API design by inspecting the main function, which contains 
the top-level workbook object as its first argument, as shown:

Every script is provided a top-level workbook object of type ExcelScript.Workbook as an argument by the main function.  Using the workbook object, 
your script interacts with the Excel workbook.  For example, the following script gets the active worksheet from the workbook and logs its name:

Similarly, methods may be invoked on the objects directly and properties such as cell values can be set using the corresponding set method.   
The following illustration gets the active cell, clears its value and formatting, and then sets a new value. 

Excel object collection handling has become as simple as managing regular object arrays.  As an example, the following code reads and prints 
worksheet names along with the number of worksheets in the workbook:

If you have recorded or created Office Scripts using the older model, it’s worth noting that such scripts will continue to work.  You can continue to 
edit and run such scripts.  However, all newly recorded and created scripts will use the simplified Office Scripts API.  

If you want to use the simplified APIs in the older scripts or convert to the new simplified API, you must start with a new script.  

In particular, do note that if your main function looks like the following, your script is using the older asynchronous model:

function main(workbook: ExcelScript.Workbook) { 

  // Your code goes here 

}

function main(workbook: ExcelScript.Workbook) { 

  // Get active worksheet 

  let sheet = workbook.getActiveWorksheet(); 

  // Log the current worksheet's name. 

  console.log(sheet.getName()) 

}

function main(workbook: ExcelScript.Workbook) { 

  // Get active cell  

  let cell = workbook.getActiveCell(); 

  // Clear the cell value and format  

  cell.clear(); 

  // Set the cell value 

  cell.setValue("Sample data"); 

}

function main(workbook: ExcelScript.Workbook) { 

  // Get all sheets as a collection.  

  const sheets = workbook.getWorksheets(); 

  // Collect names of the worksheets 

  const names = sheets.map ((sheet) => sheet.getName()); 

  // Log the names of worksheets and the total worksheets within the workbook 

  console.log(names); 

  console.log(`Total worksheets inside of this workbook: ${sheets.length}`); 

}

async function main(context: Excel.RequestContext) { 

  // Your code here 

}
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Using the New Data Types
You may recall that we detailed back in our May newsletter that there was a whole raft of new data types coming out.  But be careful, don’t hold your 
breath.  In order to be able to view these new data types, for the time being you need to meet the following criteria:

	 •	 hold a Microsoft 365 subscription with the English editing language added to Office Language Preferences
	 •	 possess a personal Microsoft Account (not one from your work or school).
	 •	 be an Office Insider in the United States (for many, but not all, of these data types)
	 •	 your system runs one of:
		  o	Windows Beta Channel Version 2007 (Build 13029.20006) or later
		  o	Mac Fast Version 16.40 (Build 20062901) or later
	 •	 be born on 29 February 1900.

OK, so maybe the last one was made up, but you get the picture…  They are not for everyone – yet (including us, although we have most of them 
now)!  They will come eventually.  Therefore, we thought we’d showcase some recent examples.

Astronomy

Movies

If you have ever wondered how many constellations are in the sky or whether Pluto really is a planet or a Disney character, then you are probably 
interested in learning new facts about the solar system.  Here is how you may get Excel to help you:

	 •	 open a blank Excel workbook
	 •	 type ‘Earth’ into A1
	 •	 select cell A1
	 •	 go to Data -> Data Types gallery -> Space to convert the text into data types
	 •	 select the icon next to Earth to display the data type card, and see all the available data you can insert into the grid.  You may also select the 	
		  ‘Insert Data’ button that appears to the right of the selected cell
	 •	 in the card, hover over the field you want to insert, and click the ‘Insert Data’ button that appears on hover for that field. 

That’s it!

The Movie data type is linked to Wolfram Alpha (like Astronomy and 
others).  Using these data types is as simple as typing text into a cell and 
telling Excel you want to convert the text to a data type.  Then, you can 
tell Excel what data fields you want to add to the grid.

To effect this:

	 •	 open a blank workbook
	 •	 type ‘Shrek’ in A1
	 •	 type ‘The Princess Bride’ in A2
	 •	 select A1:A2
	 •	 go to Data -> Data Types gallery -> Movies to convert the text into 	
		  data types
	 •	 select the icon next to the movie title to display the associated 		
		  card and all the data you can insert into the grid
	 •	 in the card, click the field you want to insert.

Again, that’s it.
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University

The University data type is yet another linked data type.  Here are some step-by-step instructions for using the University data type:

	 •	 open a blank workbook
	 •	 type 'Harvard' in A1
	 •	 type 'Yale' in A2
	 •	 select A1:A2
	 •	 go to Data -> Data Types gallery -> University to convert the text into data types
	 •	 if Excel doesn’t recognise the university, you’ll get the option to search for the correct one or try another
	 •	 select A1:A2 and click the ’Insert Data’ button that appears to the right of the selected cells to see a list of available properties
	 •	 select one or more fields to add them to each row.
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Templates

To assist with learning the ropes of these and other linked data types, Microsoft has released some templates you may play with – as long as your 
version of Excel recognises these new data types.  Examples include:

	 •	 Planets and Comets template
	 •	 Favourite Movie list
	 •	 (US) College Decision Helper template
	 •	Baby Name tracker (to showcase Names)
	 •	 Periodic Table template (to showcase Chemistry)
	 •	Relocation Helper template (to showcase City)

Enjoy (if you can)!

No more to that one either.

User Voice Finding its Voice #2
Number 2?  When was number 1?  Er, August 2017.  Sorry, this is a rather infrequent series!
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Allow for Personal User Views / Filters in Excel for the Web (2,925 votes at the time of writing)

Select Non-Adjacent Cells in Excel for the Web (823 votes)

Increase the 218 Character Filename Length Limit to Open Files in Excel (798 votes)

When using Excel Online, if you add a filter, everyone using that spreadsheet in Excel Online will see that filter.  This exasperated many, many users.  
Fortunately, Sheet View resolved this problem in mid-July.

CTRL + Click finally hit the internet in late July.  It’s so simple to select random cells in the desktop variant, but was a frustration to many for a long 
time on the InterWobble.

Until May this year, Excel could not open files with full path lengths greater than 218 characters.  This seemed crazy that Excel couldn't open a valid 
file that Microsoft’s filesystems allowed.  Users had been complaining about this since Office 2000, with well-known threads having over 11,000 
contributors!

All that changed four months ago.  Now, all Office 365 users in the monthly channel (current channel, builds 12624.20466 or above) are able to open 
and save files up to 2,034 characters, although in practice there are lower limits imposed on occasion, e.g.

	 •	Windows local and UNC files: 260 characters
	 •	OneDrive / SharePoint files synchronised to the local drive: 260 characters
	 •	OneDrive / SharePoint files opened directly from the cloud: 400 characters.

The website excel.uservoice.com continues to gain recognition and 
popularity and it is clearly becoming more effective. The idea was that 
regular Excel users could suggest improvements to the world’s second-
best software for anything and, if you get enough votes in the bag, 

Microsoft would sit up and take notice.  Microsoft recently provided an 
update on some of the improvements made and we thought we would 
share a selection of these with you from the past few months…
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Filtering when Co-authoring (710 votes)

Click Individual Cells to Sum in Excel for Mac (381 votes)

Allow for Personalised Data Labels in XY Scatter Plots for Excel for Mac (311 votes)

Translate XLOOKUP and XMATCH to PROCX and CORRESPX in Portuguese (310 votes)

You can see how popular this one was – and this took nearly three years 
to fix.  Fellow Excel MVP Bill Jelen postulated that if several users are 
working in the same workbook at the same time they should be able to 

apply a different filter to the same data yet see only their records.  It took 
until August 2020 to put right – and the response from Microsoft was a 
mite confusing, but there are a lot of happy people on UserVoice now.

Whilst Excel 2011 had the possibility to sum individual cells by typing "=", 
and then just clicking on individual cells across the workbook that you 
want to sum, and "return" when done, this functionality was no longer 

available in Excel 2016 for Mac (you had to type "=SUM(", and then click 
on the individual cells while holding down the command key RETURN.  
From April, Insiders Fast resolved this for versions 16.37 onwards.

In Excel 2016 for Mac there was no way to (easily) insert personalised 
labels into an XY scatter plot.  In the Windows version, there was the 
possibility to choose values for the labels that were not part of the XY 

plot itself but that option did not exist in the Mac counterpart.  Users 
could modify a few labels manually but with many more, they would 
hunt out UserVoice and complain.

I think it’s so easy to forget these things when you are a native English 
speaker.  80% of the world’s population cannot speak English.  1 in 33 
people speaks Portuguese, so getting the translations right for the cool 

new functions is something that should not be forgotten.  310 is a large 
number for Excel UserVoice!  This was fixed in late July.

However, since late July, Mac version 16.39 onwards has fixed this problem.
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When Copying Worksheets, Sometimes Users Have to Cycle Through 100 Million “Name Already Exists” Warnings (231 views)

Read Only Mode for Excel Desktop (225 votes)

When a Document is Locked, Good to Know Who is Editing the File (213 votes)

Oh yes, I can feel end users’ pain on this one.  We recommended for years 
not to include range names on sheets that you might copy for this very 
reason.  This was a major productivity killer and the options available to 
end your grief were usually no better than CTRL + ALT + DELETE -> End 

Program.  It took Microsoft six months to provide a solution, but in April, 
from Office 365 version 1907 onwards, there is now a “Yes to All” option 
to end your trauma.

To many users’ annoyance, Excel 2016 (and later) workbooks used to 
open in read only mode from SharePoint and Edit needed to be enabled 
everytime.  This annoyed those who opened such workbooks regularly; 

Excel just never learnt.  It’s debatable whether Microsoft fully resolved 
this, even though they claimed they had – as it appears they only fixed 
this online in April.

Many of us would agree that when a document is locked (as it's being 
edited by another user) it would be great to know who is editing the 
file offline.  This is an example where no fix was required; Microsoft just 

needed to communicate that current versions of Excel already do this, 
where the user may be identified.
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Scroll Horizontally using the Mouse (181 votes)

Allow Power Query to Extract Data from PDF Files (99 votes)

Add Chart Design Feature in Excel for the Web (11 votes)

Many asked for CTRL + SHIFT + Wheel (PC) / SHIFT + Wheel (Mac) to 
enable a horizontal scroll in Excel.  Well, since August 12, that’s now 
possible – and end users are already whingeing it should just be SHIFT 

that’s needed.  Perhaps this demonstrates people need to exert more 
self CTRL…

I am amazed how low the number of votes was for this – people ask for this all the time!  You may recall we mentioned this several months ago: 
Microsoft released a PDF data connector back in early May.

One of the things that does frustrate sometimes is that a high number 
of votes does not always guarantee a Microsoft fix.  However, the 
contrapositive also holds: sometimes, it only takes a few votes to 

get something sorted.  This was the case here: only a handful of users 
complained about the lack of ability to format charts in Excel for the Web, 
yet June saw a Format task pane roll out to deal with just such issues.
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Formulae Not Displayed in the Excel Interface Language (10 votes)

And another with few votes – but this highlights an important point.  If 
sending a frown cannot fix a bug, then UserVoice just might.  Several 
complained that the formulae were not being displayed in the same 
language as the interface (e.g. interface was in English, but the formulae 

were in French).  Microsoft resolved this within three months of the 
issue being raised.  You can judge for yourself whether you think that’s a 
good thing or a bad thing…

Beat the Boredom Challenge
With many of us currently “working from home” / quarantined, there 
are only so Zoom / Teams calls you can make before you reach your data 
limit.  Perhaps they should measure data allowance in mugs of coffee.  To 
try and keep our readers engaged, we will continue to reproduce some 

of our popular Final Friday Fix challenges from yesteryear in this and 
upcoming newsletters.  One suggested solution may be found later in this 
newsletter.  Here’s this month’s…

This month’s challenge is another one that’s deceptively easy to explain.  All you need to do is create an in-cell list that provides only non-blank 
choices from two columns of data, e.g.

Can you get this working?  It’s another of those problems that’s slightly trickier than it first appears.  Some restrictions: no VBA or anything that 
appears on the ‘Developer’ tab on the Ribbon!

Sound easy?  Try it.  One solution may be found later in this newsletter – but no reading ahead!  
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Visual Basics

Power Pivot Principles

We thought we’d run an elementary series going through the rudiments 
of Visual Basic for Applications (VBA) as a springboard for newer users.  

This month, we consider how you may speed up the runtime for macros.  

We continue our series on the Excel COM add-in, Power Pivot.  This month, we look at the ALLSELECTED function in DAX.

If you have been keeping up with this series, you will probably be au fait with creating a PivotTable that looks something like this:

Macros can run pretty slowly when you start working with large files.  There are a couple of tricks to improve the speed that your macro runs, relating to:

	 1.	 calculation time
	 2.	 screen updates.

When you run a macro, often the screen will start flickering as it jumps from step to step, and the screen frantically tries to keep up.  We can enable 
or disable this by using the code:

Application.ScreenUpdating = False

Application.ScreenUpdating = True

This determines whether the screen will continue to update and show what the macro is doing while it is running.  Turning this off (switching it to 
False) will improve the processing time of the macro, because less computing power is spent updating the screen, so it can be focused on completing 
the task at hand.

The other element that slows macros down is waiting for the file to calculate every time you take an action.  You should know that we have three 
calculation options: 

	 1.	 Automatic
	 2.	 Automatic except for Data Tables
	 3.	 Manual.  

These are represented by the following codes:

Application.Calculation = xlAutomatic

Application.Calculation = xlSemiAutomatic

Application.Calculation = xlManual

Before you run a long set of code, you can set the calculation setting to Manual, so that the code doesn’t recalculate the model every time it takes 
an action.  Of course, if you need it to calculate something before using it in the next step of a macro, you can perform a ‘manual’ calculation, using 
the code:

Application.Calculate

Just remember that if you turn off the screen updating or calculation options, make sure that you turn them back on again afterwards!

More next time.
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Let’s do something this time that is actually quite awkward to code in Excel.  We’ll start by creating the following measure:

Our PivotTable may look like this now:
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Big deal, you might say – this is akin to the ALL function discussed a couple of months ago (July newsletter).  It’s not though; it is a big deal.  To 
demonstrate, let’s also insert a slicer for the months (i.e. the field that is the subject of the ALLEXCEPT function):

Choosing months on the slicer will result in the PivotTable recalculating the total sales for the months selected:

This only considers the months selected, not all months.  Now that is not straightforward in Excel, especially if we were to apply ALLEXCEPT to a field 
that does not appear in the PivotTable.

For le coup de grâce, let’s create the following measure:
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If you don’t know what the BLANK() function is, it simply returns blank (nothing), which may suppress the context in a PivotTable.

Our PivotTable will now have different weightings of sale percentages depending on our selection of months and suppress any missing data / zero values:

More Power Pivot Principles next month.

We will create two queries, one to extract data from the Access database for each of these tables.  Assuming you are in Excel 2016 or later, we will use 
the ‘New Query’ dropdown from the ‘Get and Transform’ section of the Data tab:

Power Query Pointers
Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at 
bringing in two tables of data and summarising some of that data.

This month, let’s have two tables of data which provide information about items and charges, as shown below.  We have several goals: we need to 
report on the key item data and work out the total and average sales for each item. 
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We choose to upload the data from the ‘Microsoft Access Database’ option, and having selected the relevant database, with the tables available as 
shown below:

Since we are getting both of these tables from this database, we will check the ‘Select multiple items’ box. 

Checkboxes appear next to the tables, and we may select both tables that we are interested in, namely ‘ACCT_Order_Charges’ and ‘Items’.  We can 
create both queries at once!  We choose to ‘Edit’:
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Our two queries have now been created.  We will merge them, using the option ‘Merge Queries’ in the Combine section on the Home tab in the editor.

We choose to create a new query with our merged data, by choosing the ‘Merge Queries as New’ option.

We need to select the field Item_Key from both queries, as this is how our queries are to be linked.  Not all of our charges data is related to items; some 
are delivery charges, so not all the charges will be merged.  Let’s choose the ‘Left Outer’ join as we want all our items and only the charge data that 
relates to these items:
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A new query, ‘Merge1’, has been created. 

Next to the item data, there is a table column, which holds the data from the charges query under the heading ‘ACCT_Order_Charges’.  We may click on 
the icon next to the ‘ACCT_Order_Charges’ heading and expand this data – but that’s not all we can do.

We want to find out the total and average sales for each item, so we 
may choose to ‘Aggregate’, rather than ‘Expand’.  We could expand and 
then group my data if we needed more information from ‘ACCT_Order_
Charges’, but in this case, we are only interested in the ‘Amount’.  When 

we select the ‘Aggregate’ option we can see a number of calculations 
including ‘Sum of Amount’.  We also choose not to have a prefix.  However, 
there are more options next to the ‘Sum of Amount’, as shown below:

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

We may also see other calculations associated with the amount, so we choose the ‘Average’ too.  This selection changes the ‘Sum of Amount’ title on 
the Expand / Aggregate screen.

Choose ‘OK’ (you can click anywhere on the Expand / Aggregate screen to hide the ‘Aggregates of Amount’ dropdown) to see these results.  We have 
deleted some of the irrelevant columns below to make the results easier to view:

All we need to do now is to make our headings and query name more informative, and we have our results ready to load to Excel, using the ‘Close 
& Load’ option. 

More next month!
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Power BI Desktop Latest Updates
The latest updates released include support for Perspectives in Personalize visuals, a rectangular select for data points, dynamic formatting support 
for more visuals, Direct Query support for Q&A and several new AppSource visuals.  But of course, that’s not all.

Here’s the full list of updates:

Reporting

	 •	 Perspectives support for Personalize visuals (Preview)
	 •	Rectangular lasso select for data points (Preview)
	 •	Added dynamic formatting support for more visuals

Analytics

	 •	Direct Query support for Q&A (Preview)

Visualisations

	 •	 Linear Gauge by xViz
	 •	Advanced Pie and Donut by xViz
	 •	Ratings visual by TME AG
	 •	 Toggle switch by TME AG
	 •	Drill Down Pie PRO by MAQ Software
	 •	ADWISE RoadMap
	 •	Updates to ArcGIS Maps
	 •	 Extending administrative capabilities for AppSource visuals

Template Apps

	 •	Agile CRM Analytics for Dynamics 365

Data Preparation

	 •	 Text / CSV By Example (Preview)

Data Connectivity

	 •	 Cherwell connector
	 •	Automation Anywhere connector
	 •	Acterys connector.

Let’s take a look at each in turn.

Perspectives support for Personalize visuals (Preview)

Personalize visuals is a Preview feature that will allow you to make inline 
tweaks to visualisations in the Reading view.  For example, you may change 
a measure or dimension, or add a legend.  Previously, if you had a large 
data model, there was no way to pick a more manageable subset of fields.  

Now, in this release Perspectives support has been added for Personalize 
visuals, which will allow you to choose a subset of a model that provides a 
more focused view – making it more intelligible for end users.

It should be noted that:

	 •	 Perspectives is not meant to be used as a security mechanism, but as a tool for providing a better end-user experience.  All security for a 	
		  Perspective is inherited from the underlying model
	 •	 Perspectives in both tabular and multi-dimensional models is supported.  However, for Perspectives in multi-dimensional models you may only 	
		  set the Perspective to be the same as the base cube for the report.

As a pre-requisite, you will need to enable Personalize visuals for the report, 
as well as create one or more Perspectives that include the dimensions 
and measures that you want to interact with, for the Personalize visuals 
experience.  This will require downloading the Tabular Editor, which may 
be obtained from the Microsoft Power BI website.

Once you have downloaded Tabular Editor, you may open up your report 
in Power BI Desktop and launch Tabular Editor from the External Tools tab 
of the Ribbon, viz.
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Then you will need to right-click on the ‘Perspectives’ folder to create a new Perspective:

You can double click the text to rename the Perspective if you wish:

Next, you will need to add fields to the Perspective.  You may do this by opening the ‘Tables’ folder and right-clicking on the fields you want to show 
in the Perspective:

You should repeat this for all the fields you want to add to the Perspective.  However, it should be noted that you cannot add duplicate fields to a 
Perspective.  Therefore, if you have already added a field to a Perspective you will see the option for that Perspective is disabled subsequently.

After you have added all the fields, you should ensure you save the Perspective in both the Tabular Editor and also in Power BI.
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After you have saved the new Perspective to the model and the Power BI report, navigate to the Format pane for the page, where there is a new 
section for ‘Personalize visual’.

The ‘Report-reader perspective’ is set to ‘Default fields’ initially.  However, when you open the dropdown you will see the other Perspectives 
created too:
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Once for you have set the Perspective for that page, the Personalize visuals experience for that page will be filtered down to that Perspective.  Using 
‘Apply to all pages’, you may also choose to apply your Perspective setting to all existing pages in your report.

Rectangular lasso select for data points (Preview)

It was back in the April update that Microsoft released the rectangle select 
for visuals, which provided a more convenient way to select multiple 

visuals at once.  This update provides a Preview of that functionality now 
extended to data points for line, area and scatter charts.

When editing a report, you’ll now be able to create a selection rectangle 
by holding down the CTRL key whilst clicking and dragging within a 
visual.  When you let go of the mouse, all points overlapping the selection 
rectangle will be selected.  Your previous selections will be preserved, and 

already-selected data points will be deselected.  It will be as though you 
held down the CTRL key and individually clicked every single point that 
overlaps the selection rectangle.
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If you click and drag while holding down the SHIFT key instead, your previous selections will be preserved, but this time your already-selected data 
points will remain selected.  This key is strictly for adding data points to your selection, not removing them.

As usual, you may clear your current selection by clicking an empty space on the plot area (without holding down any key).

When viewing a report, in addition to the above controls, you will be able to create a selection rectangle with a simple click and drag within a visual.  
This action will count as starting a new selection and will not preserve your currently selected points.
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This action is not available in Edit mode because clicking and dragging within a visual, with no held keys, moves the visual instead.

Furthermore, it should be noted that:

	 •	 line, area and scatter chart support rectangle select.  Indeed, Microsoft has announced they plan to add support for more visuals in upcoming 	
		  updates
	 •	 the number of data points you can select at once is limited to 300
	 •	when viewing a report in Power BI Service, rectangle select will be enabled only if the Preview feature was enabled when the report was 	
		  saved and published on Power BI Desktop.

Added dynamic formatting support for more visuals

It was three years ago that Microsoft released cell-level formatting for 
multidimensional AS models and cell-level formatting for multidimensional 
AS models for multi-row cards.  Dynamic format strings, also known as 

cell-level formatting, enable you to set a different format string for each 
measure data point.  Therefore, each column in a column chart or each 
row in a table can be formatted differently.  For example:

Originally, this was supported for the older version of table and matrix, 
the current table and matrix, card and the multi-row card.  However, this 

update has added dynamic formatting for the following visuals (sorry, 
there are only a few to choose from):

	 •	 column chart
	 •	 bar chart
	 •	 stacked column chart
	 •	 stacked bar chart
	 •	 scatter chart
	 •	 line chart
	 •	 area chart

	 •	map
	 •	 shape map
	 •	waterfall chart
	 •	 donut chart
	 •	 pie chart
	 •	 tree map.

Note that dynamic format strings are applied to:

	 •	measure values on ToolTips
	 •	measure values data labels
	 •	measure axes.

For example:
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Direct Query support for Q&A (Preview)

Linear Gauge by xViz

Advanced Pie and Donut by xViz

Q&A now supports SQL Direct Query sources, including SQL Server 2019, 
Azure SQL database and Azure Synapse Analytics.  You can now use Q&A 
to ask natural language questions against these data sources.  Prior to this 
update, Q&A was not available for datasets with any Direct Query sources.   

But there’s more.

You will also notice one minor change to the behaviour of Q&A when it is 
operating in Direct Query mode.  There is now a ‘Submit’ button, which is 

now available when typing in your question.  This is to prevent overloading 
the Direct Query source with unnecessary queries as the user types in their 
question.

It should be noted that presently, other Direct Query sources are not 
supported for Q&A.  Microsoft doesn’t block Q&A altogether if you have 
other Direct Query sources in your dataset, but some questions may not 
be answered correctly or may return errors instead.

xViz has released a new PBI Certified version (1.1.5) of the Linear Gauge with anew Gauge option: the ‘Progress Bar’ for advanced use cases.  This 
version includes data label enhancements for better positioning and formatting capabilities.  Gauge width and margin settings have also been added for 
additional design flexibility.

The following are the list of new features added to this xViz Linear Gauge:

	 •	 new Gauge Type: Progress Bar
	 •	 custom data labels for each Tier
	 •	 Tier label with active label option
	 •	 Tier limits: start and end range for each Tier
	 •	 horizontal and vertical orientation
	 •	 conditional formatting improvements
	 •	 data label enhancements:
			   o	 placement options: inside / outside and left / right / centre / top / bottom
			   o	 display option: actual value / percentage / both
			   o	 enhanced look and feel: separate font size, weight and colour
	 •	Gauge width and margin for better label positioning
	 •	 axis label formatting: scaling, show nth label.

xViz Advanced Pie and Donut provides several chart options, covering both 
Pie and Donut chart use cases into a single visual.  Pie charts help visualise 
part-to-whole relationships with a maximum of six slices.  Along with the 
semi-circle pie and 3D option, this visual also supports variable width pie 

charts, which requires two values and one category field.
Donut charts are a variant of the pie chart with a blank centre.  This 
provides a better data intensity ratio and an alternative visualisation.

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Ratings visual by TME AG

Toggle switch by TME AG

The following are the list of key features for xViz Advanced Pie and Donut chart:

	 •	 several chart options: pie, semi-circle pie, variable width pie, donut and arc donut
	 •	 top n ranking with ‘others’: display top items and group the rest together as ‘others’
	 •	 donut charts with totals in the middle
	 •	 3D styling of pie and donut charts
	 •	 styling options: set patterns for individual slices to make them stand out
	 •	 gradient colouring
	 •	 data label formatting
	 •	 number formatting
	 •	 drilldown
	 •	 conditional formatting.

This new visual provides a variety of rating options for various performance indicators:

This new visual acts as a trigger to show and hide data with a toggle switch.

Features include:

	 •	 ratings can be displayed in different indicator styles including stars, circles, etc.
	 •	 it shows progress in percentage
	 •	 it shows selected stars / total stars.

Formatting options include:

	 •	 six different shapes are available
	 •	 rating indicators count can be changed
	 •	 indicator selection and deselection colour can be set
	 •	 display shadow
	 •	 show and hide percentage and selected indicator value and set their position top or bottom
	 •	 change label colours with their font size and font family.
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Features include:

	 •	 best to use with string data types
	 •	 users may choose multiple values for switch on and off, but these values must be separated by a comma
	 •	 it can accept an unlimited number of values for on and off
	 •	 users may set the switch colour.

Drill Down Pie PRO by MAQ Software

Drill Down Pie PRO is the eighth visual in the ZoomCharts Advanced Visuals suite, which has recently been rebranded to Drill Down Visuals.

As the name suggest, the visual has drilldown functionality, as well as smooth animations and customisation options.  These features enable report 
developers to create Power BI reports that are both intuitive and flexible.

For example, with multilevel drilldown, users can explore data categories by clicking directly on the slice.  Visual graphics will indicate the number of 
drilldown levels available, as well as serve as a navigation guide.
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Key features for both creators and users include:

	 •	 others slice: you may define the number of slices visible and automatically group the rest of the data together under a separate slice
	 •	 data sorting: sort slices in ascending or descending order, by value or category name
	 •	 customisation options: set colour for each slice, adjust value labels, add legends, set fill colour mode, fonts sizes and colours, and customise 	
		  ToolTip(s)
	 •	measure support: add and visualise calculations
	 •	 touch-driven slicer: filter the report page by using the visual itself (no need for external slicers)
	 •	 on-chart interactions: click or touch to drill down, select and filter data
	 •	mobile friendly: use on touch and multi-touch devices.

This may be used for the presentation and management of:

	 •	 project portfolio / single projects
	 •	 transition / change management plans
	 •	 product features roadmap / development / market introduction
	 •	 various campaigns.

ADWISE RoadMap

This visual allows you to plan, roadmap and time schedule phases and milestones.  This can help you present your project, product or campaign plans, 
or plans of whatever else that can be time-scheduled.
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Key features of the visual include:

	 •	 bars / phases: title, description, colour based upon selected categories / values
	 •	milestones: title, color and shape, based upon selected categories / values
	 •	 groups specification and labelling
	 •	 two timelines with adjustable scale, positioning and labelling
	 •	 today and target lines, with custom text
	 •	 other adjustments: font type, size, weight and style, text wrapping, gridlines, etc.

Updates to ArcGIS Maps

ArcGIS Maps for Power BI is an existing mapping visual available with 
Power BI Desktop.  In this release, multiple tools have been added in the 
Format pane, that enable Power BI report authors to provide additional 
capabilities to users.

All Power BI Desktop users may use ArcGIS Maps for Power BI by simply 
clicking on the Esri visual and then dragging data to the location field.  You 

can geocode, detect patterns in your data with different map styles and 
find similar or nearby locations.  You can also access (US) demographics 
and infographics information, in order to gain better context.

If you purchase an add-on license, you can unlock additional features, 
including geocoding more points per map, add multiple reference layers 
and access Esri’s global curated data.

With this release, there’s a new interface, where all tools may be accessed in one place:

	 •	 click on the ‘Analysis’ widget to see the tools that you need to analyse the data you have mapped
	 •	 click on the ‘Settings’ widget to access help, or on the ‘Basemaps’ widget to select a basemap for your data. 
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This release includes something called ‘Lock extent’, which is a new tool 
that restricts map panning to a new area.  This may be accessed under 
the ‘Map Tools’ tab.  By enabling this feature, you can ensure that your 
users see only the location that you have preselected in your report.  The 
map does not pan even if a user searches for a location that happens to be 
outside the selected location.

To provide users with more flexibility with map presentation, there is also 
an option to display demographics cards and table of contents on either 

side of a map by choosing ‘Layers Position’, under the ‘Layers’ tab.  Power 
BI report authors now also have an option to turn the ‘layers’ feature on 
or off for end users.  If report authors want to ensure that the table of 
contents always stays on the map, they can do so by simple turning the 
anchor button on.  Additionally, Power BI report authors now have an 
option to turn the zoom feature on or off for report viewers too.

The smart mapping functionality has been improved.  This feature 
automatically analyses your data and makes data-driven styling 
suggestions.  Now with an improved colour scheme, you can more clearly 
visualise the different categories in which your data is divided on a map.  

You may also make more accurate heatmaps, to clearly identify the location 
that has the maximum density of an attribute.  Additionally, now when you 
drag addresses to the location field well, the visual automatically detects 
the data type and creates polygons or points on the map, as appropriate.
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With the new and improved geosearch feature, you can simply type an 
address in the search bar, find the right location and pin it on the map.  You 
also have an option to turn the geosearch feature on if you would like to 

provide an option of geosearching to report viewers.  The pinned location 
is displayed on the map, but it isn’t stored for later use.

Extending administrative capabilities for AppSource visuals

This update sees the administrative capabilities relating to AppSource visuals updated.  AppSource visuals can now be managed in Admin portal.

AppSource visuals will retain certification and will continue to be updated 
automatically when a new version is available in AppSource.  The changes 
to Power BI visuals settings will not affect the organisational visuals.

Additionally, Power BI administrators may pick any visual to show up 
automatically in the Visualization pane of the entire signed-on organisation 
members, either in Power BI Desktop or the Service.

The visual icon will show side by side with the default visuals.
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Agile CRM Analytics for Dynamics 365

Text / CSV By Example (Preview)

Agile CRM Analytics is a set of Power BI analytical reports for Microsoft 
Dynamics 365 to give you better insights from your Customer Relationship 
Management (CRM) data.  This is a free trial version to show you the 

possibilities and allow you to have a play.  With Agile CRM Analytics, Sales 
and Marketing teams are equipped with shareable, actionable insights.

‘Text / CSV By Example’ in Power Query is now available as a public Preview 
feature.  To start using ‘Text / CSV By Example’, you should enable ‘Import 
text using examples’ in the Options -> Preview Features page.

When using the Text / CSV connector, you will see a new option to ‘Extract 
Table Using Examples’ on the bottom-left corner of the file preview dialog.

You will need to enter your URL for the Dynamics 365 API:

The dataset will start refreshing and schedule refresh will be set automatically.
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Cherwell connector

Automation Anywhere connector

Acterys connector

Upon clicking that new button, you’ll be taken into the ‘Extract Table Using Examples’ experience, allowing you to specify sample output values for the 
data you’d like to extract from your Text / CSV file.

Once you have finished constructing that table, you can click Load / Transform to complete the Get Data flow.  You should take note of how the resulting 
queries contain a detailed breakdown of all the steps that were inferred for the data extraction, which are just standard query steps that you can 
customise as necessary.

This connector enables real-time collaboration and accelerates incident resolution.  The Cherwell connector allows you to bring data from your instance 
of Cherwell Service Management into Microsoft Power BI for analysis and reporting.

Automation Anywhere is a Robotic Process Automation (RPA) platform 
that enables automation of Enterprise business processes.  The Power 
BI connector from Automation Anywhere enables a business user to 
integrate RPA data in their corporate Power BI dashboards, without 

relying on IT resources to create custom integration solutions.  The Power 
BI connecter can retrieve operational, strategic and business metrics from 
Automation Anywhere’s RPA platform.

Acterys is an integrated platform for Data Warehouse Automation, Corporate Performance Management (CPM) and Financial Planning & Analytics 
(FP&A) for Microsoft Azure, Power BI and Excel.

This connector will be available in the ‘Other’ section of the ‘Get data’ dialog.

This connector will also be available in the ‘Other’ section of the ‘Get data’ dialog.
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It enables users to achieve results quickly, and provides a unified platform 
for all their analytics, planning, forecasting, consolidation and project 
planning requirements.  With the new Acterys Power BI Connector users 
can now connect to their Acterys environment with one click (without the 
need to access the database directly or setting up a Power BI dataset) and 

add the required models to Power BI governed by their Acterys (Active 
Directory / Microsoft Account) user rights and audit trails.

And guess what?  This connector will be available in the ‘Other’ section of 
the ‘Get data’ dialog.

That’s it for this month – more next month, we’re sure!

Power BI Service and Mobile Latest Updates
You may have noticed these updates emanate more sporadically than their Desktop counterparts – but they do come out from time to time!  Here’s 
the full list of the latest updates:

	 •	 Link Previews for Power BI in Microsoft Teams
	 •	 Timely Premium capacity overload alerts
	 •	 Public Preview of Power BI deployment pipelines
	 •	 Template app for Power BI Premium Capacity Metrics app
	 •	Refresh summary for Premium capacity administrators
	 •	General Availability of Shared and Certified datasets
	 •	 Page view for Paginated Reports
	 •	Updated Mobile authoring in Power BI Desktop
	 •	Updated breadcrumbs in Power BI Service

	 •	 Sensitivity labels persist when a Power BI report is embedded 	
	 	 in an app
	 •	 Power BI data protection Generally Available
	 •	 Label inheritance upon creation of new content
	 •	Updates for Power BI Mobile:
	 	 	 o	 Dark mode for Power BI iOS app
	 	 	 o	 Apply bookmarks in Presentation mode
	 	 	 o	 Show your bookmarks in slideshows.

Let’s take a look at each in turn.

Link Previews for Power BI in Microsoft Teams

Timely Premium capacity overload alerts

Back in May, Microsoft announced a public Preview of link previews 
for Power BI in Microsoft Teams.  Link previews help users know more 

information about the URL to help colleagues find, open and subscribe to 
the data they need.

These updates see a new feature that sends automated emails whenever 
Power BI senses a Premium capacity is overloaded.  These emails are 
sent to users subscribed to Service Interruption Notifications.  Each email 
alert contains a breakdown of the operations running on datasets loaded 

on the capacity during the 15 minutes leading to the overload detected.  
The breakdown shows what was to the total duration of CPU core time 
consumed by each operation.  The top consumers of CPU core time are the 
heaviest contributors to the capacity overload.
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Public Preview of Power BI deployment pipelines

Template app for Power BI Premium Capacity Metrics app

Refresh summary for Premium capacity administrators

Microsoft has introduced a new way to manage content lifecycle within 
Power BI Premium with deployment pipelines.  With this feature, 
enterprise BI teams may build an efficient and reusable process by 
maintaining development, test and production environments.  BI 

creators can incrementally transition new or updated content between 
environments, reconfiguring them with the appropriate data connections 
and permissions.

There has been a release of the familiar Power BI Premium Capacity 
Metrics app as a template application.  This application will continue 
to support users in monitoring the health of premium capacities and 
making informed decisions about the best use of them, including when 

to scale them so that users experience fewer issues.  As a template app, 
you may now connect to the underlying dataset and customise the 
report as required.

These updates provide a new and simple way to monitor and ensure 
the successful execution of scheduled refreshes on Power BI Premium 
capacities using the Refresh Summary page in the Admin Portal.  Now, 

users may obtain an overview of all scheduled refreshes activity on their 
Premium capacity with one click.
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General Availability of Shared and Certified datasets

Page view for Paginated Reports

Updated Mobile authoring in Power BI Desktop

Shared and Certified datasets are now Generally Available.  With Shared 
and Certified datasets, Power BI users may easily discover and reuse 

enterprise-wide semantic models.  They can be shared across workspaces, 
fostering reuse and maintain that all important single source of truth.

These updates have enhanced paginated reports in the Power BI Service 
by adding a new page view option.  With this feature, users may make 

the paginated reports appear like a page on the browser whilst retaining 
the ability to change parameters, click on links in the reports, etc.

Mobile authoring reports have now been improved in Power BI Desktop.  The new experience has capabilities such as a new phone emulator and 
canvas grid, updated Visualization pane, together with overlaid visuals.
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Updated breadcrumbs in Power BI Service

Sensitivity labels persist when a Power BI report is embedded in an app

Power BI data protection Generally Available

Label inheritance upon creation of new content

Updates for Power BI Mobile:

Breadcrumbs in the Power BI Service have been updated to only showcase 
the containing folder of the artifact.  When content is shared, users will be 
able to see which workspace the content came from instead of ‘Shared 

with me’ – which was shown before.  With this improvement, users have 
a consistent experience of locating their content when viewing artifact in 
the Power BI Service.

Power BI business reports are often embedded in business applications 
such as Microsoft Teams, SharePoint or an organisation’s website.  Now, 
when you embed sensitive information, the label applied on your reports 

and dashboards will be visible in the embedded view and persist when 
data is exported to Excel.

Microsoft has also announced the General Availability (GA) of Power BI 
data projection capabilities.  Microsoft Information Protection sensitivity 
labels provide a simple way for you to classify critical content in Power 
BI without compromising productivity or the ability to collaborate.  
Sensitivity labels may be applied on datasets, reports, dashboards and 

dataflows.  When data is exported from Power BI to Excel, PowerPoint 
or PDF files, Power BI automatically applies a sensitivity label on the 
exported file and protects it, according to the label’s file encryption 
settings.  This way, your sensitive data remains protected no matter 
where it is.

When new reports and dashboards are created in the Power BI Service, 
they automatically inherit the sensitivity label previously applied on the 
parent dataset or report.  For example, a new report created on top of a 

dataset that has a “Highly Confidential” sensitivity label will automatically 
receive the “Highly Confidential” label too.

Finally, Microsoft has also updated the Power BI mobile apps with the following features:

	 •	Dark model for Power BI IOS application
	 •	Apply bookmarks in Presentation mode
	 •	 Show your bookmarks in slideshows.
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DARK MODE FOR POWER BI IOS APP

APPLY BOOKMARKS IN PRESENTATION MODE

SHOW YOUR BOOKMARKS IN SLIDESHOWS

Users may now opt in to use the dark mode on the Power BI iOS mobile 
application.  With this feature, you will see light text on a dark background, 

reducing the brightness of the screen and making it easier to see your 
content.  You can switch between themes in the app appearance settings.

You can now apply personal and report bookmarks to report pages when presenting in Presentation mode on your Windows application.

The formula for the probability density function is given by

The cumulative distribution function is given by

where I is the regularised beta function:

In other words, use the F.DIST function in Excel when you need to and try not to ask too many questions.

You can also you can include report and personal bookmarks in your slideshows, automatically as part of the presentation, to highlight specific insights 
in your data.

That’s it for now – more “sporadically” no doubt!

The A to Z of Excel Functions: F.DIST
Named after Sir Ronald Aylmer Fisher, a British statistician, geneticist and 
mega-genius, the F-distribution is defined as a continuous distribution 
obtained from the ratio of two chi-square distributions and used in 
particular to test the equality of the variances of two normally distributed 
variances a continuous probability distribution, which means that it is 
defined for an infinite number of different values.  This analysis of variance 
is often referred to as “ANOVA”, which I thought was a cheap car.

I’m glad we have cleared that up then, eh?  F.DIST for an explanation..?

To be “slightly” clearer, the F-distribution can be used for several types 
of applications, including testing hypotheses about the equality of two 

population variances and testing the validity of what is known as a multiple 
regression equation, i.e. a formulaic attempt to model the relationship 
between two or more explanatory variables and a response variable by 
fitting a linear equation to observed data.  

The F-distribution shares one important property with the Student’s 
t-distribution: probabilities are determined by a concept known as 
degrees of freedom.  Unlike the Student’s t-distribution, the F-distribution 
is characterised by two different types of degrees of freedom: numerator 
and denominator degrees of freedom.

The F-distribution has two important properties:

1.	 It’s defined only for positive values.
2.	 It’s not symmetrical about its mean; instead, it’s positively skewed.

A distribution is positively skewed if the mean is greater than the median 
(the mean is the average value of a distribution, and the median is the 
midpoint; half of the values in the distribution are below the median and 
half are above).  This function returns the F probability distribution.   You 
can use this function to determine whether two data sets have different 
degrees of diversity.  

A good example of a positively skewed distribution is household incomes.  
Suppose that half of the households in a country have incomes below 
$50,000 and half have incomes above $50,000; this indicates that the 
median household income is $50,000.  Among households with incomes 
below $50,000, the smallest possible value is $0.  Among households with 
incomes above $50,000, there may be incomes of several million dollars 
per year.  This imbalance between incomes below the median and above 
the median causes the mean to be substantially higher than the median.  
Suppose for example that the mean income in this case is $120,000.  This 
shows that the distribution of household incomes is positively skewed.
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This image (above) shows a graph of the F-distribution for different 
combinations of numerator and denominator degrees of freedom.  
In each case, numerator degrees of freedom are listed first, and 
denominator degrees of freedom are listed second.  The level of 
significance in each case is 0.05.

A level of significance is used to test a hypothesis.  An hypothesis test 
begins with a null hypothesis; this is a statement that’s assumed to be 
true unless there is strong contrary evidence.  There is also an alternative 
hypothesis; this is a statement that is accepted in place of the null 
hypothesis if there’s sufficient evidence to reject the null hypothesis.

The level of significance, designated alpha, refers to the probability of 
incorrectly rejecting the null hypothesis when it is actually true.  This is 
known as a Type I error.  By contrast, a Type II error occurs when you fail 
to reject the null hypothesis when it’s actually false.  Therefore, with a 

level of significance of 0.05, there is a 5 percent chance of committing a 
Type I error.

The figure shows that the distribution isn’t defined for negative values 
(as you can see, no negative values appear along the horizontal axis).  
Additionally, as the number of degrees of freedom increases, the shape 
of the distribution shifts to the right.  The distribution has a long right tail 
(more formally, it’s skewed to the right, or positively skewed).

Important: This (right-tailed) F.DIST function enhances an older function 
so that it may provide improved accuracy and whose names better reflect 
their usage.  Although the previous function is still available for backward 
compatibility, you should consider using this newer function from now 
on, because the older variant may not be available in future versions of 
Excel, according to Microsoft.  However, this is NOT the equivalent of 
FDIST.  Interestingly, it is F.DIST.RT which supersedes FDIST.

The F.DIST function employs the following syntax to operate:

F.DIST(x,deg_freedom1,deg_freedom2,cumulative)

The F.DIST function has the following arguments:

	 •	x: this is required and represents the value at which to evaluate the function
	 •	deg_freedom1: this is also required and denotes the numerator degrees of freedom
	 •	deg_freedom2: this is again required and represents the denominator degrees of freedom
	 •	 cumulative: again, required.  This is a logical value that indicates which form of the function to use.  If cumulative is TRUE, F.DIST returns the 	
		  cumulative distribution function; if FALSE, it returns the probability density function.

It should be further noted that: 

	 •	 if any argument is non-numeric, F.DIST returns the #VALUE! error value
	 •	 if x < 0, F.DIST returns the #NUM! error value
	 •	 if deg_freedom1 or deg_freedom2 is not an integer, it is truncated
	 •	 If either deg_freedom1 or deg_freedom2 is strictly less than 1, F.DIST returns the #NUM! error value.

Please see our example below:
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The A to Z of Excel Functions: F.DIST.RT

As explained above, the F-distribution is defined as a continuous 
distribution obtained from the ratio of two chi-square distributions and 
used in particular to test the equality of the variances of two normally 
distributed variances a continuous probability distribution, which means 
that it is defined for an infinite number of different values.  This analysis 
of variance is often referred to as “ANOVA”, which I still think is a cheap 
car!  (Yes, I am going to keep using this joke…)

In slightly simpler terms, the F-distribution can be used for several 
types of applications, including testing hypotheses about the equality 
of two population variances and testing the validity of what is known 
as a multiple regression equation, i.e. a formulaic attempt to model the 
relationship between two or more explanatory variables and a response 
variable by fitting a linear equation to observed data.  

The F-distribution shares one important property with the Student’s 
t-distribution: probabilities are determined by a concept known 
as degrees of freedom.  Unlike the Student’s t-distribution, the 
F-distribution is characterized by two different types of degrees of 
freedom: numerator and denominator degrees of freedom.

The F-distribution has two important properties:

	 1.	 It’s defined only for positive values.
	 2.	 It’s not symmetrical about its mean; instead, it’s positively skewed.

A distribution is positively skewed if the mean is greater than the median 
(the mean is the average value of a distribution, and the median is the 
midpoint; half of the values in the distribution are below the median 
and half are above).  This function returns the (right-tailed) F probability 
distribution (degree of diversity) for two datasets.   

This distribution is a relatively new one.  The associated F statistic is a 
ratio (a fraction). There are two sets of degrees of freedom; one for the 
numerator and one for the denominator.  As mentioned above, the F 
distribution is derived from the Student’s t-distribution. The values 
of the F distribution are squares of the corresponding values of the 
t-distribution. 

To calculate the F ratio, two estimates of the variance are made:

	 1.	Variance between samples: An estimate of σ2 that is the variance of the sample means multiplied by n (when the sample sizes are the same).  	
		  If the samples are different sizes, the variance between samples is weighted to account for the different sample sizes.  The variance is also called 	
		  variation due to treatment or explained variation

	 2.	Variance within samples: An estimate of σ2 that is the average of the sample variances (also known as a pooled variance).  When the sample 	
		  sizes 	are different, the variance within samples is weighted.  The variance is also called the variation due to error or unexplained variation:

		  •	 SSbetween = the sum of squares that represents the variation among the different samples
		  •	 SSwithin = the sum of squares that represents the variation within samples that is due to chance.

To find a “sum of squares” means to add together squared quantities that, in some cases, may be weighted.  MS means “mean square”.  MSbetween is the 
variance between groups, and MSwithin is the variance within groups.

To calculate the sum of squares and the mean square, let:

	 •	k = the number of different groups
	 •	nj = the size of the jth group
	 •	 sj = the sum of the values in the jth group
	 •	n = total number of all the values combined (total sample size: ∑nj)
	 •	x = one value: ∑x = ∑sj

The sum of squares of all values from every group combined: ∑x2

The between group variability is therefore
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and the total sum of squares is given by

The explained variation is therefore the sum of squares representing variation among the different samples:

whereas the mean square (variance estimate) that is due to chance (unexplained) is

where

	 •	n = the sample size
	 •	dfnumerator = k – 1
	 •	dfdenominator = n – k
	 •	 s2

pooled = the mean of the sample variances (pooled variance)

	 •	          = the variance of the sample means.

The one-way ANOVA test depends on the fact that MSbetween can be 
influenced by population differences among means of the several groups.  
Since MSwithin compares values of each group to its own group mean, the 
fact that group means might be different does not affect MSwithin.

The null hypothesis says that all groups are samples from populations 
having the same normal distribution.  The alternate hypothesis says that 
at least two of the sample groups come from populations with different 
normal distributions.  If the null hypothesis (H0) is TRUE, MSbetween and 
MSwithin should both estimate the same value.

To be clear, the null hypothesis says that all the group population means 
are equal.  The hypothesis of equal means implies that the populations 
have the same normal distribution, because it is assumed that the 
populations are normal and that they have equal variances.

So, all of this brings us to the F-ratio or F-statistic, defined as

If MSbetween and MSwithin estimate the same value (following the belief that 
H0 is TRUE), then the F-ratio should be approximately equal to one (1).  
Mostly, just sampling errors would contribute to variations away from 
one.  As it turns out, MSbetween consists of the population variance plus a 
variance produced from the differences between the samples.  MSwithin 
is an estimate of the population variance.  Since variances are always 
positive, if the null hypothesis is FALSE, MSbetween will generally be larger 
than MSwithin.  Then the F-ratio will be larger than one.  However, if the 
population effect is small, it is not unlikely that MSwithin will be larger in a 
given sample.

The foregoing calculations were done with groups of different sizes.  If 
the groups are the same size, the calculations simplify somewhat, and the 
F-ratio can be written as:

MSbetween and MSwithin can be written as follows:

The degrees of freedom for different groups (i.e. the degrees of freedom for the numerator) is calculated as df = k – 1, whereas the equation for errors 
within samples (degrees of freedom for the denominator) is calculated as dfwithin = n – k.

Further, the mean square (variance estimate) explained by the different groups is

This should be compared with the unexplained variation, namely the sum of squares representing variation within samples due to chance:

SSwithin=SStotal−SSbetween
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Now that you have had the statistics lecture, you may use the worksheet 
function F.DIST or the function F.DIST.RT in Excel to decide whether or 
not your calculated F-ratio is in the region of rejection.  

For F.DIST, you supply a value for the value at which to evaluate the 
function (x), a value for each degree of freedom (numerator and 
denominator), and a value (TRUE or FALSE) for the final argument 
(cumulative).  If the value for cumulative is TRUE, F.DIST returns the 
probability of obtaining an F-ratio of at most as high as yours if the 
hypothesis is TRUE (in Excel, this is called the “left-tail” probability).  

A level of significance is used to test a hypothesis.  An hypothesis test 
begins with a null hypothesis; this is a statement that’s assumed to be 
true unless there is strong contrary evidence.  There is also an alternative 
hypothesis; this is a statement that is accepted in place of the null 
hypothesis if there’s sufficient evidence to reject the null hypothesis.

If that probability is greater than 1 – alpha, where alpha is the level of 
significance, you reject the null hypothesis.  If the value for cumulative 
is FALSE, F.DIST returns the height of the F-distribution at your value (x).  
Unless you are considering creating a chart, you probably (get it?) won’t 
use FALSE as the value for cumulative.

F.DIST.RT returns the probability of obtaining an F-ratio at least as high 
as yours if the null hypothesis were TRUE (Excel calls this the “right-tail” 
probability).  If that value is less than alpha, you should reject H0.  In 
practice, F.DIST.RT is more straightforward and replaces FDIST.

Now this is important: This F.DIST.RT function replaces the older function 
FDIST so that it may provide improved accuracy and whose names better 
reflect their usage.  Although the previous function is still available for 
backward compatibility, you should consider using this newer function 
from now on, because the older variant may not be available in future 
versions of Excel, according to Microsoft.

The F.DIST.RT function employs the following syntax to operate:

F.DIST(x,deg_freedom1,deg_freedom2)

The F.DIST function has the following arguments:

	 •	x: this is required and represents the value at which to evaluate the function
	 •	deg_freedom1: this is also required and denotes the numerator degrees of freedom
	 •	deg_freedom2: this is again required and represents the denominator degrees of freedom.

It should be further noted that: 

	 •	 if any argument is non-numeric, F.DIST.RT returns the #VALUE! error value
	 •	 if x < 0, F.DIST.RT returns the #NUM! error value
	 •	 if deg_freedom1 or deg_freedom2 is not an integer, it is truncated
	 •	 If either deg_freedom1 or deg_freedom2 is strictly less than 1, F.DIST returns the #NUM! error value
	 •	F.DIST.RT is calculated as F.DIST.RT = P(F > x), where F is a random variable that has an F-distribution with deg_freedom1 and deg_freedom2 	
		  degrees of freedom.

Please see my example below: 

The A to Z of Excel Functions: F.INV

Now that you have had the above statistics lecture, you may use the 
worksheet function F.INV to return a value for the F-ratio when you 
supply an area under the curve (i.e. the associated probability), plus the 

number of degrees of freedom for both the numerator and denominator 
alike, that define the distribution.
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For example, let’s consider a researcher who was testing four groups consisting of 10 people each, and that alpha was set to a level of 0.05 (5%).  
Then, an F-value could be looked up in a statistics text or else you could use the following formula to determine the critical F-value:

=F.INV(0.95,3,36).

Further, prior to Excel 2010, you would have to use the following formula instead:

=FINV(0.05,3,36).

The F.INV function employs the following syntax to operate:

F.INV(probability,deg_freedom1,deg_freedom2)

The F.INV function has the following arguments:

	 •	 probability: this is required and represents the probability associated with the F-cumulative distribution
	 •	 deg_freedom1: this is also required and denotes the numerator degrees of freedom
	 •	 deg_freedom2: this is again required and represents the denominator degrees of freedom.

It should be further noted that: 

	 •	 if any argument is non-numeric, F.INV returns the #VALUE! error value
	 •	 if probability < 0 or probability >1, F.INV returns the #NUM! error value
	 •	 if deg_freedom1 or deg_freedom2 is not an integer, it is truncated
	 •	 If either deg_freedom1 or deg_freedom2 is strictly less than 1, F.INV returns the #NUM! error value.

Please see our example below: 

The traditional approach has been to obtain a critical F-value early on 
in an experiment.  The researcher would know how many groups would 
be involved, and would have some knowledge of how many individual 

observations would be available at the conclusion of the experiment.  
The variable alpha, the level of significance, would be chosen before any 
outcome data is available.

Important: This F.INV function replaces the older function FINV so that 
it may provide improved accuracy and whose names better reflect their 
usage.  Although the previous function is still available for backward 

compatibility, you should consider using this newer function from now 
on, because the older variant may not be available in future versions of 
Excel, according to Microsoft.

These two formulae will return the same value, 2.866.  The older 
function, FINV, returns the F-value that cuts off the rightmost 5% of the 
distribution; the newer F.INV function returns the F-value that cuts off 
the leftmost 95% of the distribution.  Be careful!!

Once this has been determined (using either of these Excel functions), 
the ANOVA test may now be completed , with the calculated F compared 

to the critical F, and if the former is greater than the latter, the null 
hypothesis (H0) will be rejected.

In summary, the F.INV function returns the inverse of the F probability 
distribution. If p = F.DIST(x,...), then F.INV(p,...) = x.  The F distribution 
can be used in an F-test that compares the degree of variability in two 
data sets.

The A to Z of Excel Functions: F.INV.RT
As with F.INV, let’s again consider a researcher who was testing four groups consisting of 10 people each, and that alpha was set to a level of 0.05 
(5%).  Then, an F-value could be looked up in a statistics text or else you could use the following formula to determine the critical F-value:

=F.INV.RT(0.05,3,36).

Important: This function also replaces the older function FINV so that it may provide improved accuracy and whose names better reflect their usage.  
Although the previous function is still available for backward compatibility, you should consider using this newer function from now on, because the 
older variant may not be available in future versions of Excel, according to Microsoft.

Further, prior to Excel 2010, you would have to use the following formula instead:

=FINV(0.05,3,36).

These two formulae will return the same value, 2.866.  Effectively F.INV(p,…) = F.INV.RT(1-p,…).
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Once this has been determined (using either of these Excel functions), 
the ANOVA test may now be completed , with the calculated F compared 
to the critical F, and if the former is greater than the latter, the null 
hypothesis (H0) will be rejected.

In summary, the F.INV.RT function returns the inverse of the F 
probability distribution. If p = F.DIST.RT(x,...), then F.INV.RT(p,...) = x.  
The F distribution can be used in an F-test that compares the degree of 
variability in two data sets.

The F.INV.RT function employs the following syntax to operate:

F.INV.RT(probability,deg_freedom1,deg_freedom2)

The F.INV function has the following arguments:

	 •	 probability: this is required and represents the probability associated with the F-cumulative distribution
	 •	 deg_freedom1: this is also required and denotes the numerator degrees of freedom
	 •	 deg_freedom2: this is again required and represents the denominator degrees of freedom.

It should be further noted that: 

	 •	 if any argument is non-numeric, F.INV.RT returns the #VALUE! error value
	 •	 if probability < 0 or probability >1, F.INV.RT returns the #NUM! error value
	 •	 if deg_freedom1 or deg_freedom2 is not an integer, it is truncated
	 •	 If either deg_freedom1, deg_freedom2 is strictly less than 1 or deg_freedom2 is greater than or equal to 10^10, F.INV.RT returns the #NUM! 	
		  error value.

Please see another example below:

The A to Z of Excel Functions: F.TEST
This function replaces the older function FTEST so that it may provide improved accuracy and whose names better reflect their usage.  Although the 
previous function is still available for backward compatibility, you should consider using this newer function from now on, because the older variant 
may not be available in future versions of Excel, according to Microsoft.

In summary, the F.TEST function returns the result of an F-test, i.e. the two-tailed probability that the variances in array1 and array2 are not 
significantly different.

The F.TEST function employs the following syntax to operate:

F.TEST(array1,array2)

The F.TEST function has the following arguments:

	 •	 array1: this is required and represents the first array or range of data
	 •	 array2: this is also required and denotes the second array or range of data.

It should be further noted that: 

	 •	 the arguments must be either numbers or names, arrays or references that contain numbers
	 •	 if an array or reference argument contains text, logical values or empty cells, those values are ignored
	 •	 cells with the value zero will be included
	 •	 if the number of data points in array1 or array2 is less than two (2), or if the variance of array1 or array2 is zero, F.TEST returns the #DIV/0! error.

Please see our final example below: 

More Excel Functions next month…
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Beat the Boredom Suggested Solution
This month’s challenge was another deceptively simple question.  All you needed to do was to create an in-cell list that provided only non-blank choices 
from two columns of data, e.g.

Forgetting the need to ignore blanks, there is another issue you may have encountered:

But let’s back up…

Given our challenge specifically stated that VBA or “anything that appears on the ‘Developer’ tab on the Ribbon” should not be used (e.g. combo boxes), 
this really restricted us to creating a list using Excel’s Data Validation feature.

By default, you can type anything into any cell in Excel, but you can restrict cell contents to “valid” data entries.  This is the concept of data validation and 
Excel’s Data Validation feature.  To access Data Validation, it can be found in the ‘Data Tools’ grouping on the ‘Data’ tab of the Ribbon:

It’s probably easier to use the old Excel 2003 keyboard shortcut (ALT + D + L), but the Excel 2007 onwards keyboard shortcut ALT + A + V + V works too.  
This displays the ‘Data Validation’ dialog box, which by default allows ‘Any value’ to be contained within the selected cell(s):
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This can be changed by changing the selection in the ‘Allow:’ drop down box.  It may be modified to any of the following:

Most of these criteria do exactly what they say on the tin: by choosing ‘Decimal’, the input must be a number, whereas ‘Whole Number’ allows for 
integers only, etc.  However, it is ‘List’ that we will focus on here, as this creates an in-cell drop-down box:

With ‘List’ selected, the dialog box prompts for a source for the list.  

In the illustration, the entries have been typed in, separated by a comma.  
However, the data can use cell references which are in a column – or a 
row – as long as the cells are on the same worksheet.  This can be limiting 
and a viable workaround is to name a range instead (see Naming Names).  
For lists, we also strongly recommend using the ‘In-cell dropdown’ which 
provides a dropdown list of valid entries once the cell has been selected.

There are tricks you can employ to make the list source more flexible, 
typically using the INDIRECT function (please see Being Direct About 
INDIRECT for more details), but that won’t help you here.  No matter how 
you try to combine your two lists, you are likely to receive the following 
error message:

So how do you get around this?  Well, you have to go for a less elegant solution – and essentially build a list in one location (column or row) only.
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Let’s start by specifying our example, viz.

Cells F11:F22 have been named List1 and cells H11:H22 have been called List2 (surprise, surprise).

Next, I am going to add some “helper” calculations as follows:

	 •	 The formula in cell E11 is
		  =(COUNTA(F11)+MAX(E$10:E10))*COUNTA(F11)
	 	 This adds one to the running total starting in blank cell E10 if and only if the corresponding cell in column F is not blank (COUNTA essentially 	
	 	 counts the number of non-blank cells in a range).  This formula is copied down the column and the range has been named ListCounter01

	 •	 A similar formula is copied into cells G11:G22:
		  =(COUNTA(H11)+MAX(G$10:G10))*COUNTA(H11)
	 	 This range has been named ListCounter02

	 •	 This just leaves cell G10:
		  =MAX(E11:E22)
	 	 which takes the maximum figure from column E, so a “true” running total is computed.  This cell has been named Max_List1.

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Next, some interim calculations were created:

These three values (7, 8 and 15) were named First_Column_Count, Second_Column_Count and Total_Count respectively.  These values are required 
as follows:

	 •	Total_Count calculates how many items there will be in the amalgamated list to be generated
	 •	First_Column_Count determines whether the item number in the list should come from List1 (if the record number is less than or equal to 7) or 	
		  List2 (if the record number is between 8 and the Total_Count, 15)
	 •	Second_Column_Count is created for completeness – and in case there is a third list of data at a later point in time.

A single list may now be generated (we strongly recommend keeping all your list data / lookup references on one sheet so they may be located quickly 
in larger spreadsheets):

The formula in cell F20 is

=IF(MAX($F$19:$F19)=Total_Count,"",MAX($F$19:$F19)+1)

This simply creates a counter running from 1 to Total_Count.

The formula in cell G20 is a little more sophisticated:

=IF($F20="","",IF($F20<=First_Column_Count,INDEX(List1,MATCH($F20,ListCounter01,0)),INDEX(List2,MATCH($F20,ListCounter02,0))))

This uses the function combination INDEX MATCH (see Are Things LOOKing UP for INDEX and MATCH?) to reference the next non-blank entry in List1 
and, once this has been exhausted, List2.

It’s easy from here.  The data validated list may simply reference cells G20:G39 on this worksheet  (called Calculations), or if you want to get more 
sophisticated, you can exclude the blank entries in the range (cells G35:G39) by defining what is known as a dynamic range name using the formula

=OFFSET(Calculations!$G$20,,,MAX(Total_Count,1),)
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You can find out more about the OFFSET function and creating dynamic ranges in our article The Onset of OFFSET.

Assuming you have used this method and named the range LU_Dynamic_List, all that needs to be now is complete the definition of the data validated 
list, viz.

Nothing to it – except have a rudimentary understanding of Data Validation, COUNTA, MAX, range names, INDEX, MATCH and OFFSET!  That’s why we 
liked this question!

Until next time.

SumProduct on the Excel Blog
Very hot off the press, SumProduct has been beating the COVID-19 lockdowns and has been getting itself “out and about” on Microsoft’s Excel Blog:

You can read more about what happened with Excel Virtually Global here 
and on our own website.

But there’s more.

Our very own Liam Bastick will be part of Microsoft’s inaugural Ask an 
Excel MVP live event series!  Microsoft is starting this new series with an 
hour live event featuring various MVPs working out the answers to three 
to five Excel questions, and Liam has been given the honour of being the 
very first trailblazer / guinea pig (you decide).

This will be held on Wednesday 30 September at 2pm Pacific Time / 
Thursday 1 October at 7am Australian Eastern Seaboard Time.  More 
details will be made available nearer the time at Excel Blog and in 
SumProduct News.

Be there or, er, don’t.

mailto:contact@sumproduct.com
http://www.sumproduct.com
https://www.sumproduct.com/thought/onset-of-offset
https://techcommunity.microsoft.com/t5/excel-blog/excel-mvp-liam-bastick-looking-back-at-excel-virtually-global/ba-p/1612740
https://www.sumproduct.com/blog/article/excel-virtually-global-2020-a-personal-look-back
https://www.sumproduct.com/news
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, we thought we would 
SHIFT our thoughts to the FUNCTION keys…

Keystroke What it does

SHIFT + F1 What is… (Help)

SHIFT + F2 Insert / edit comment

SHIFT + F3 Function wizard

SHIFT + F4 Find next (from most recent search)

SHIFT + F5 Find dialog

SHIFT + F6 Previous pane

Keystroke What it does

SHIFT + F7 Thesaurus

SHIFT + F8 Add to Selection mode

SHIFT + F9 Calculate sheet

SHIFT + F10 Activate context menu (right-click)

SHIFT + F11 Insert new worksheet

SHIFT + F12 Save
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Location Course Date Date Duration Duration

Online (Australia) Power Pivot, Power Query and Power BI 7 - 9 Sep 2020 09:00-17:00 AEST (-1 day) 23:00-07:00 GMT 3 Days

Online (Australia) Power Pivot, Power Query and Power BI 9 - 11 Nov 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 16 Nov 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 17 - 18 Nov 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 14 - 16 Dec 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties. To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course. 

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.
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